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Bài 4Làm việc với báo cáo cơ bản

Page 2
                        

Tìm hiểu các kĩ thuật để thiết kế biểu mẫu hiệu quả và
 nhập dữ liệu chính xác
 Tìm hiểu một số hướng dẫn thiết kế biểu mẫu cho ứng
 dụng doanh nghiệp
 Tìm hiểu cách tạo các biểu mẫu nâng cao và đặc biệt
 Nhắc lại bài cũ
 Tìm hiểu các kĩ thuật để thiết kế biểu mẫu hiệu quả và
 nhập dữ liệu chính xác
 Tìm hiểu một số hướng dẫn thiết kế biểu mẫu cho ứng
 dụng doanh nghiệp
 Tìm hiểu cách tạo các biểu mẫu nâng cao và đặc biệt
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1. Tìm hiểu về Báo cáo (Report) trong MS Access
 2. Tìm hiểu các thành phần chính của báo cáo
 3. Tìm hiểu các dạng báo cáo
 4. Tìm hiểu các cách tạo báo cáo
 5. Tìm hiểu các định dạng xuất báo cáo
 6. Tìm hiểu các quy tắc thiết kế báo cáo hiệu quả cho
 doanh nghiệp
 Mục tiêu bài học hôm nay
 1. Tìm hiểu về Báo cáo (Report) trong MS Access
 2. Tìm hiểu các thành phần chính của báo cáo
 3. Tìm hiểu các dạng báo cáo
 4. Tìm hiểu các cách tạo báo cáo
 5. Tìm hiểu các định dạng xuất báo cáo
 6. Tìm hiểu các quy tắc thiết kế báo cáo hiệu quả cho
 doanh nghiệp
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Báo cáo (Report): đối tượng CSDL của Access được sử dụng để định
 dạng, tính toán, tổng hợp các dữ liệu được chọn (từ các bảng, truy
 vấn) và in ra
 Dữ liệu nguồn của báo cáo là một hoặc nhiều bảng, truy vấn hoặc
 dữ liệu được lấy từ câu lệnh SQL
 1. Giới thiệu về báo cáo
 Báo cáo (Report): đối tượng CSDL của Access được sử dụng để định
 dạng, tính toán, tổng hợp các dữ liệu được chọn (từ các bảng, truy
 vấn) và in ra
 Dữ liệu nguồn của báo cáo là một hoặc nhiều bảng, truy vấn hoặc
 dữ liệu được lấy từ câu lệnh SQL
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Ví dụ: Báo cáo hiển thị danh sách nhân viên và phân nhóm hiển thị
 theo Phòng làm việc của nhân viên
 Giới thiệu về báo cáo
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Ý nghĩa của báo cáo:
 Tổ chức và hiển thị dữ liệu theo nhóm
 Thống kê dữ liệu theo các hình thức như: tính tổng, tính trung bình,…
 Báo cáo có thể chứa báo cáo phụ (Subreport) và biểu đồ (chart)
 Dữ liệu được trình bày kèm theo hình ảnh, hình vẽ… nhằm thu hút
 người xem
 Giới thiệu về báo cáo
 Ý nghĩa của báo cáo:
 Tổ chức và hiển thị dữ liệu theo nhóm
 Thống kê dữ liệu theo các hình thức như: tính tổng, tính trung bình,…
 Báo cáo có thể chứa báo cáo phụ (Subreport) và biểu đồ (chart)
 Dữ liệu được trình bày kèm theo hình ảnh, hình vẽ… nhằm thu hút
 người xem
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Cấu trúc chung của báo cáo (nhìn từ thiết kế):
 2. Các thành phần chính của báo cáo
 Đầubáo cáo
 Đầutrang
 Slide 4 - Làm việc với báo cáo cơ bản 7
 Chântrang
 Chi tiếtbáo cáo
 Chânbáo cáo
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Cấu trúc chung của báo cáo (nhìn từ sản phẩm):
 Các thành phần chính của báo cáo
 Đầubáo cáo
 Đầutrang
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 Chântrang
 Chi tiếtbáo cáo
 Chânbáo cáo
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Đầu báo cáo (Report Header): xuất hiện ở đầu báo cáo, thường
 chứa tiêu đề, logo, ngày tháng…
 Chân báo cáo (Report Footer): xuất hiện ở cuối báo cáo, thường
 chứa thông tin tổng cho toàn báo cáo
 Đầu trang (Page Header): xuất hiện ở đầu mỗi trang, thường được
 sử dụng để hiển thị số trang các đầu cột và một số thông tin khác
 Chân trang (Page Footer): xuất hiện ở cuối mỗi trang, có thể chứa
 số trang nếu số trang không được đưa ra ở đầu trang
 Các thành phần chính của báo cáo
 Đầu báo cáo (Report Header): xuất hiện ở đầu báo cáo, thường
 chứa tiêu đề, logo, ngày tháng…
 Chân báo cáo (Report Footer): xuất hiện ở cuối báo cáo, thường
 chứa thông tin tổng cho toàn báo cáo
 Đầu trang (Page Header): xuất hiện ở đầu mỗi trang, thường được
 sử dụng để hiển thị số trang các đầu cột và một số thông tin khác
 Chân trang (Page Footer): xuất hiện ở cuối mỗi trang, có thể chứa
 số trang nếu số trang không được đưa ra ở đầu trang
 Slide 4 - Làm việc với báo cáo cơ bản 9
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Phần chi tiết (Details): xuất hiện trong thân chính của báo cáo, hiển
 thị một hoặc nhiều trường cho mỗi bản ghi theo dạng cột hoặc
 bảng.
 Ngoài ra, báo cáo có thể có hai thành phần khác có trong các báo
 cáo nhóm là Đầu nhóm (Group Header)/Chân nhóm (Group Footer):
 Đầu nhóm (Group Header): xuất hiện ở đầu nhóm bản ghi để xác định
 nhóm
 Chân nhóm (Group Footer): xuất hiện sau bản ghi cuối cùng của nhóm
 và chứa thông tin tổng về nhóm
 Các thành phần chính của báo cáo
 Phần chi tiết (Details): xuất hiện trong thân chính của báo cáo, hiển
 thị một hoặc nhiều trường cho mỗi bản ghi theo dạng cột hoặc
 bảng.
 Ngoài ra, báo cáo có thể có hai thành phần khác có trong các báo
 cáo nhóm là Đầu nhóm (Group Header)/Chân nhóm (Group Footer):
 Đầu nhóm (Group Header): xuất hiện ở đầu nhóm bản ghi để xác định
 nhóm
 Chân nhóm (Group Footer): xuất hiện sau bản ghi cuối cùng của nhóm
 và chứa thông tin tổng về nhóm
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Page 11
                        

Báo cáo dạng cột:
 Là báo cáo đơn giản nhất
 Liệt kê mỗi bản ghi thành một trang
 Thường bao gồm nhiều trang
 Hiển thị dữ liệu trên một cột nhưng khi in sẽ ra nhiều cột.
 Thường sử dụng để lập các thẻ học viên, thẻ kho
 Ví dụ:
 3. Các dạng báo cáo
 Báo cáo dạng cột:
 Là báo cáo đơn giản nhất
 Liệt kê mỗi bản ghi thành một trang
 Thường bao gồm nhiều trang
 Hiển thị dữ liệu trên một cột nhưng khi in sẽ ra nhiều cột.
 Thường sử dụng để lập các thẻ học viên, thẻ kho
 Ví dụ:
 Slide 4 - Làm việc với báo cáo cơ bản 11
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Báo cáo dạng bảng:
 Mỗi bản ghi trong bảng dữ liệu được in thành một dòng
 Chỉ hiển thị các bản ghi được lựa chọn
 Ngắn gọn hơn báo cáo cột và thường sử dụng cho các báo cáo dạng
 danh sách liệt kê
 Ví dụ:
 Các dạng báo cáo
 Báo cáo dạng bảng:
 Mỗi bản ghi trong bảng dữ liệu được in thành một dòng
 Chỉ hiển thị các bản ghi được lựa chọn
 Ngắn gọn hơn báo cáo cột và thường sử dụng cho các báo cáo dạng
 danh sách liệt kê
 Ví dụ:
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Báo cáo dạng nhóm:
 Tương tự báo cáo dạng bảng nhưng dữ liệu được phân theo từng nhóm
 Trên mỗi nhóm có thể thực hiện các thống kê như tính tổng, trung bình
 Thường sử dụng để thống kê theo từng nhóm
 Ví dụ:
 Các dạng báo cáo
 Báo cáo dạng nhóm:
 Tương tự báo cáo dạng bảng nhưng dữ liệu được phân theo từng nhóm
 Trên mỗi nhóm có thể thực hiện các thống kê như tính tổng, trung bình
 Thường sử dụng để thống kê theo từng nhóm
 Ví dụ:
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4.1. Trình tự chung4.2. Các cách tạo báo cáo4.3. Các điều khiển của báo cáo
 4. Tạo báo cáo
 Slide 4 - Làm việc với báo cáo cơ bản 14

Page 15
                        

Bước 1: Phân tích yêu cầu và xác định dữ liệu nguồn (bảng/truy
 vấn) cho báo cáo
 Bước 2: Tùy thuộc loại báo cáo và dữ liệu nguồn để chọn cách thiết
 kế
 Bước 3: Thêm các điều khiển; định dạng, đặt thuộc tính cho báo
 cáo. Các điều khiển thường xuất hiện như: Text Box, Label,
 Rectangle, Line
 Bước 4: Lưu và đóng báo cáo
 4.1. Trình tự chung
 Bước 1: Phân tích yêu cầu và xác định dữ liệu nguồn (bảng/truy
 vấn) cho báo cáo
 Bước 2: Tùy thuộc loại báo cáo và dữ liệu nguồn để chọn cách thiết
 kế
 Bước 3: Thêm các điều khiển; định dạng, đặt thuộc tính cho báo
 cáo. Các điều khiển thường xuất hiện như: Text Box, Label,
 Rectangle, Line
 Bước 4: Lưu và đóng báo cáo
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Cách 1: Dùng công cụ Report Wizard để tạo báo cáo sử dụng các
 hướng dẫn của hệ thống
 Là cách tạo báo cáo đơn giản nhất sử dụng các hướng dẫn của hệ
 thống
 Các bước chính tạo báo cáo:
 4.2. Các cách tạo báo cáo
 Cách 1: Dùng công cụ Report Wizard để tạo báo cáo sử dụng các
 hướng dẫn của hệ thống
 Là cách tạo báo cáo đơn giản nhất sử dụng các hướng dẫn của hệ
 thống
 Các bước chính tạo báo cáo:
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 Bước 1: Chọn các cột củabảng/truy vấn đưa vào
 báo cáo
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Các cách tạo báo cáo
 Bước 2: Lựa chọn cộtnhóm và cột làm tiêu chí
 sắp xếp
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 Bước 2: Lựa chọn cộtnhóm và cột làm tiêu chí
 sắp xếp
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Các cách tạo báo cáo
 Bước 3: Thêm các điềukhiển, các cột tính toán
 (nếu cần)
 Slide 4 - Làm việc với báo cáo cơ bản 18
 Bước 4: Định dạng trangbáo cáo
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Cách 2: Dùng công cụ Report Design để tạo báo cáo do người
 dùng tùy chỉnh
 Có 2 cách mở báo cáo mới:
 Cách 1: Lựa chọn Create -> Report Design
 Cách 2:
 Lựa chọn Create -> Blank Report
 Tiếp đến lựa chọn Format -> View -> Design View
 Các cách tạo báo cáo
 Cách 2: Dùng công cụ Report Design để tạo báo cáo do người
 dùng tùy chỉnh
 Có 2 cách mở báo cáo mới:
 Cách 1: Lựa chọn Create -> Report Design
 Cách 2:
 Lựa chọn Create -> Blank Report
 Tiếp đến lựa chọn Format -> View -> Design View
 Slide 4 - Làm việc với báo cáo cơ bản 19

Page 20
                        

Các bước chính tạo báo cáo:
 Các cách tạo báo cáo
 Bước 1: Chọn các cột củabảng/truy vấn đưa vào
 báo cáo
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 Bước 2: Thêm các điềukhiển khác và tùy chỉnh
 (vị trí, màu sắc…)
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Các cách tạo báo cáo
 Bước 3: Chọn các cột làmtiêu chí nhóm và sắp xếp
 dữ liệu
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 Bước 4: Điều chỉnh cácthuộc tính của báo cáo
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Các điều khiển nằm trong nhóm Controls của menu Design
 4.3. Các điều khiển của báo cáo
 Các điều khiển nhưtiêu đề, logo, Check
 Box, Button,…
 Slide 4 - Làm việc với báo cáo cơ bản 22
 Các điều khiển nhưtiêu đề, logo, Check
 Box, Button,…
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Phân thành 3 nhóm:
 Điều khiển buộc (Bound Control): được gắn vào 1 cột nào đó trong
 Bảng/Truy vấn, dùng để hiển thị, nhập liệu hoặc cập nhật giá trị (text
 box, combo box, list box…)
 Điều khiển không buộc (Unbound Control): không có dữ liệu nguồn,
 hiển thị thông tin, chú thích (line, label, rectangle…)
 Điều khiển có thể tính toán được (Calculated Control): dữ liệu là 1 biểu
 thức. Biểu thức này có thể bao gồm những trường trong Bảng/Truy
 vấn, giá trị hàm, hoặc giá trị lấy từ điều khiển khác.
 Các điều khiển của báo cáo
 Phân thành 3 nhóm:
 Điều khiển buộc (Bound Control): được gắn vào 1 cột nào đó trong
 Bảng/Truy vấn, dùng để hiển thị, nhập liệu hoặc cập nhật giá trị (text
 box, combo box, list box…)
 Điều khiển không buộc (Unbound Control): không có dữ liệu nguồn,
 hiển thị thông tin, chú thích (line, label, rectangle…)
 Điều khiển có thể tính toán được (Calculated Control): dữ liệu là 1 biểu
 thức. Biểu thức này có thể bao gồm những trường trong Bảng/Truy
 vấn, giá trị hàm, hoặc giá trị lấy từ điều khiển khác.
 Slide 4 - Làm việc với báo cáo cơ bản 23

Page 24
                        

Sử dụng một số điều khiển của báo cáo:
 Thêm logo, tiêu đề:
 Các điều khiển của báo cáo
 Slide 4 - Làm việc với báo cáo cơ bản 24
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Tạo ảnh nền cho báo cáo: Sử dụng các thuộc tính Pictures trong bảng thuộc
 tính Property Sheet
 Các điều khiển của báo cáo
 Slide 4 - Làm việc với báo cáo cơ bản 25
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Một số thao tác trên điều
 khiển:
 Chỉ định thứ tự chọn điều
 khiển:
 Có thể chỉ định thứ tự được
 chọn cho các điều khiển khi
 người dùng ấn phím Tab
 Sử dụng công cụ Tab Order
 trong menu Arrange để chỉ
 định thứ tự được chọn cho
 các điều khiển
 Các điều khiển của báo cáo
 Một số thao tác trên điều
 khiển:
 Chỉ định thứ tự chọn điều
 khiển:
 Có thể chỉ định thứ tự được
 chọn cho các điều khiển khi
 người dùng ấn phím Tab
 Sử dụng công cụ Tab Order
 trong menu Arrange để chỉ
 định thứ tự được chọn cho
 các điều khiển
 Slide 4 - Làm việc với báo cáo cơ bản 26
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Gán tự động định dạng:
 Để định dạng cho màu sắc, font chữ của dữ liệu trogn các điều khiển
 Sử dụng công cụ AutoFormat trong menu Arrange
 Các điều khiển của báo cáo
 Slide 4 - Làm việc với báo cáo cơ bản 27
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Thêm điều kiện định dạng hiển thị:
 Dữ liệu trong điều khiển có thể hiển thị khác nhau phụ thuộc vào điều kiện
 gắn cho điều khiển đó.
 Sử dụng công cụ Conditional trong menu Design
 Các điều khiển của báo cáo
 Thêm điều kiện định dạng hiển thị:
 Dữ liệu trong điều khiển có thể hiển thị khác nhau phụ thuộc vào điều kiện
 gắn cho điều khiển đó.
 Sử dụng công cụ Conditional trong menu Design
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Thuộc tính Page Header/Page Footer:
 Quy định thành phần đầu trang/chân trang của báo cáo có hiển thị cùng với
 đầu/chân báo cáo hay không.
 Có 4 giá trị của thuộc tính Page Header/Page Footer:
 All Pages: đầu trang/chân trang xuất hiện trên tất cả các trang của báo cáo
 Not with Rpt Hrd: đầu trang xuất hiện trên tất cả các trang của báo cáo, ngoại trừ
 trang đầu tiên chứa đầu báo cáo
 Not with Rpt Frt: chân trang xuất hiện trên tất cả các trang của báo cáo, ngoại trừ
 trang chứa chân báo cáo
 Not with Rpt Hrd /RptFrt: đầu trang xuất hiện trên tất cả các trang của báo cáo,
 ngoại trừ các trang chứa đầu báo cáo và chân báo cáo
 4.4. Một số thuộc tính chung của báo cáo
 Thuộc tính Page Header/Page Footer:
 Quy định thành phần đầu trang/chân trang của báo cáo có hiển thị cùng với
 đầu/chân báo cáo hay không.
 Có 4 giá trị của thuộc tính Page Header/Page Footer:
 All Pages: đầu trang/chân trang xuất hiện trên tất cả các trang của báo cáo
 Not with Rpt Hrd: đầu trang xuất hiện trên tất cả các trang của báo cáo, ngoại trừ
 trang đầu tiên chứa đầu báo cáo
 Not with Rpt Frt: chân trang xuất hiện trên tất cả các trang của báo cáo, ngoại trừ
 trang chứa chân báo cáo
 Not with Rpt Hrd /RptFrt: đầu trang xuất hiện trên tất cả các trang của báo cáo,
 ngoại trừ các trang chứa đầu báo cáo và chân báo cáo
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Ví dụ: Thiết lập thuộc tính Page Header là “Not with Rpt Hrd”
 Một số thuộc tính chung của báo cáo
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Thuộc tính Picture Pages cho phép một hình ảnh chèn vào báo cáo
 có hiển thị hay không.
 Một số giá trị của thuộc tính Picture Pages:
 All Pages: Hình ảnh xuất hiện trên tất cả các trang báo cáo
 First Page: Hình ảnh chỉ xuất hiện trên trang đầu của báo cáo
 No Pages: Hình ảnh không xuất hiện trên bất kì trang nào của báo cáo
 Một số thuộc tính chung của báo cáo
 Thuộc tính Picture Pages cho phép một hình ảnh chèn vào báo cáo
 có hiển thị hay không.
 Một số giá trị của thuộc tính Picture Pages:
 All Pages: Hình ảnh xuất hiện trên tất cả các trang báo cáo
 First Page: Hình ảnh chỉ xuất hiện trên trang đầu của báo cáo
 No Pages: Hình ảnh không xuất hiện trên bất kì trang nào của báo cáo
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Thuộc tính của điều khiển trong báo cáo:
 Quy định các tự động điều chỉnh về kích thước của điều khiển
 Một số giá trị điều chỉnh kích thước cho điều khiển
 CanGrow =Yes: điều khiển tự động điều chỉnh kích thước theo phương
 dọc
 CanShink = Yes: tự động co điều khiển nếu không có dữ liệu trong đó
 (điều khiển trống)
 HideDuplicate = Yes: che dữ liệu trong điều khiển nếu giá trị của nó
 trùng với mẫu tin trước đó, làm cho báo cáo dễ đọc hơn
 Một số thuộc tính chung của báo cáo
 Thuộc tính của điều khiển trong báo cáo:
 Quy định các tự động điều chỉnh về kích thước của điều khiển
 Một số giá trị điều chỉnh kích thước cho điều khiển
 CanGrow =Yes: điều khiển tự động điều chỉnh kích thước theo phương
 dọc
 CanShink = Yes: tự động co điều khiển nếu không có dữ liệu trong đó
 (điều khiển trống)
 HideDuplicate = Yes: che dữ liệu trong điều khiển nếu giá trị của nó
 trùng với mẫu tin trước đó, làm cho báo cáo dễ đọc hơn
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5.1. In báo cáo trên giấy
 5.2. Gửi báo cáo vào mail
 5.3. Chuyển báo cáo ra các định dạng khác
 5. Xuất báo cáo
 5.1. In báo cáo trên giấy
 5.2. Gửi báo cáo vào mail
 5.3. Chuyển báo cáo ra các định dạng khác
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Trước khi in báo cáo trên giấy
 cần được căn chỉnh
 Cách làm:
 Sử dụng chế độ Print Preview hoặc
 Layout View
 Sử dụng tab Page Layout để thiết
 lập kích thước trang, hướng giấy, căn
 lề, định dạng cột.
 Sử dụng Page Setup để định dạng
 các thuộc tính in
 5.1. In báo cáo trên giấy
 Trước khi in báo cáo trên giấy
 cần được căn chỉnh
 Cách làm:
 Sử dụng chế độ Print Preview hoặc
 Layout View
 Sử dụng tab Page Layout để thiết
 lập kích thước trang, hướng giấy, căn
 lề, định dạng cột.
 Sử dụng Page Setup để định dạng
 các thuộc tính in
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Sử dụng công cụ Office -> Email
 Bạn lựa chọn định dạng muốn in ra của báo cáo (.txt, .html…)
 Access sẽ chuyển báo cáo sang định dạng được chọn và đính kèm
 vào mail của bạn để gửi đi
 5.2. Gửi báo cáo vào mail
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Chuyển báo cáo sang định dạng Word
 Sử dụng công cụ External Data -> Word để chuyển báo cáo sang định
 dạng Word
 Chuyển báo cáo sang định dạng PDF hoặc XPS
 Sử dụng định dạng PDF hoặc XPS cho phép giữ nguyên khuôn dạng
 báo cáo như thiết kế, không bị xô lệch như khi chuyển sang các định
 dạng khác (Word, email…)
 Lựa chọn Office -> Save As -> Find add-ins for other file formats
 5.3. Chuyển báo cáora các định dạng khác
 Chuyển báo cáo sang định dạng Word
 Sử dụng công cụ External Data -> Word để chuyển báo cáo sang định
 dạng Word
 Chuyển báo cáo sang định dạng PDF hoặc XPS
 Sử dụng định dạng PDF hoặc XPS cho phép giữ nguyên khuôn dạng
 báo cáo như thiết kế, không bị xô lệch như khi chuyển sang các định
 dạng khác (Word, email…)
 Lựa chọn Office -> Save As -> Find add-ins for other file formats
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Sử dụng lại những báo cáo có sẵn
 Chỉ đưa đủ thông tin lên báo cáo, không đưa thừa
 Thêm số trang, ngày tháng vào báo cáo
 Quan tâm đến độ ưu tiên sắp xếp của các cột dữ liệu
 6. Các quy tắcthiết kế hiệu quả cho doanh nghiệp
 Sử dụng lại những báo cáo có sẵn
 Chỉ đưa đủ thông tin lên báo cáo, không đưa thừa
 Thêm số trang, ngày tháng vào báo cáo
 Quan tâm đến độ ưu tiên sắp xếp của các cột dữ liệu
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Quan tâm đến kích thước hiển thị của báo cáo
 Báo cáo phải dễ nhìn, dễ đọc
 Nên sắp xếp và phân nhóm dữ liệu
 Tổ chức cách hiển thị dữ liệu bằng cách sử dụng các
 dòng, đường viền, đường phân cách các trang…
 Các quy tắcthiết kế hiệu quả cho doanh nghiệp
 Quan tâm đến kích thước hiển thị của báo cáo
 Báo cáo phải dễ nhìn, dễ đọc
 Nên sắp xếp và phân nhóm dữ liệu
 Tổ chức cách hiển thị dữ liệu bằng cách sử dụng các
 dòng, đường viền, đường phân cách các trang…
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Báo cáo là đối tượng CSDL của Access được sử dụng để định dạng,
 tính toán, tổng hợp dữ liệu và in ra dữ liệu.
 5 thành phần chính của báo cáo gồm: đầu/chân báo cáo, đầu/chân
 mỗi trang báo cáo, phần chi tiết. Trong đó phần chi tiết là phần
 quan trọng chứa đa số dữ liệu của báo cáo
 3 dạng báo cáo chính: dạng bảng, dạng cột, dạng nhóm
 Tổng kết
 Báo cáo là đối tượng CSDL của Access được sử dụng để định dạng,
 tính toán, tổng hợp dữ liệu và in ra dữ liệu.
 5 thành phần chính của báo cáo gồm: đầu/chân báo cáo, đầu/chân
 mỗi trang báo cáo, phần chi tiết. Trong đó phần chi tiết là phần
 quan trọng chứa đa số dữ liệu của báo cáo
 3 dạng báo cáo chính: dạng bảng, dạng cột, dạng nhóm
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Hai công cụ thiết kế báo cáo: Report Wizard, Report Design trong
 đó Report Wizard là công cụ dễ dùng nhất nhưng Report Design cho
 phép tùy chỉnh nhiều hơn.
 Có thể in báo cáo ra các định dạng khác nhau như: giấy, email, txt,
 pdf…
 Thiết kế báo cáo cho doanh nghiệp nên chọn lọc dữ liệu đưa vào
 báo cáo và đảm bảo các yếu tố thẩm mĩ cho giao diện
 Tổng kết
 Hai công cụ thiết kế báo cáo: Report Wizard, Report Design trong
 đó Report Wizard là công cụ dễ dùng nhất nhưng Report Design cho
 phép tùy chỉnh nhiều hơn.
 Có thể in báo cáo ra các định dạng khác nhau như: giấy, email, txt,
 pdf…
 Thiết kế báo cáo cho doanh nghiệp nên chọn lọc dữ liệu đưa vào
 báo cáo và đảm bảo các yếu tố thẩm mĩ cho giao diện
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